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1. Inledning

Nar Minitab har 6ppnats finns det tva fonster av intresse, det Gversta som kallas Session Win-
dow (Gversétts har med resultatfonster) och det nedersta som kallas Worksheet (Oversatts har
med datafonster). Datafonstret paminner om ett Excelark, men det finns skillnader.

Wl Minitab - Untithed
Fe ER Dgta sk Fa Gaoh Eftor Took Widow bl Assitegt
EH & ni- TIAE QTS €T30 /CEE = It Lalvdlo

[ =l (o =] Hla k]

2011-10-05 21:47:22

Velceae Lo Minitab, peess F1 Coc help.
I

‘Wekome to Mnktab, press F1 For help. Edesble

En korning i Minitab gar i allmanhet till sa att man forst laser in data i datafonstret, sedan
valjer en meny for att bestaimma vad man skall gora for analys pa data, och darefter far man
utskriften i resultatfonstret. Om man ocksa har gjort en figur sa kommer den i ett eget fonster.

Kontrollera forst om din version av Minitab vill ha decimalpunkt eller decimalkomma, om
det blir fel framgar det av att kolumnen &ndras till C1-T som visar att det ar en textkolumn,
och textkolumner gr inte att anvanda till numeriska berakningar®. 1 det foljande antas att
programmet ar installt for decimalpunkt.

Exempel 1. Inledande exempel
Berékna medelvarde och standardavvikelse for foljande vérden:
8.7,8.1,9.8,6.1, 7.1.
(Kontrollera alltsa om din version av Minitab anvander decimalpunkt och inte decimal-
komma.)
L&s in vardena i kolumn c1 enligt (variabeln kallas héar alltsa y)

! Om man av misstag har fatt en kolumn med siffror att bli en textkolumn s& kan man &ndra det med kommandot
Data » Code » Text to Numeric...



1
2
3
4 6.1
3
6
7

(I senare avsnitt beskrivs hur man ger datafonstret ett annat namn &n Worksheet 1.) Nar nu
vardena &r inl&sta kan man gora analysen genom att valja lamplig meny. | det har fallet valjs

Stat » Basic Statistics » Display Descriptive Statistics...

Wil Minitab - Mib16.MPJ

Ble Edt Data Calc | Stst Graph Editor Tools

= » Dis|
FH & A E
S
[ B r %3 P
ANOYA v @i Graphical Summary...
DoE v
| 1Z 1-Sample Z...
Control Charts 3
| 11 LSamplet..
2011-1 wuality Tools »
el 2t z-Samplat...
Reliabilty/Survival b
tabity! 4 pared.
Mulivariate »
Tirne Series » 1P 1 Proportion...
Tables » 2P 2Proportions...
[ETEEETENES » sp 1-Sample Paisson Rate...
EDA » &% 2-Sample Poisson Rate. .,
Power and Sample Size ¥ g2 | Varisnce...

s 2 variances...

£0R Correlation. ..

£0W Covariance...

A
A& normality Test...

<)

e
[T 3 Govdneezof i TesFor Poszon-. ([

B c c2 [ [ c5 6 c7 c8 9 [

Pa den meny som kommer upp finns nu lite olika satt att vélja den variabel man vill rdkna pa,
men det enklaste ar att forst stalla markdren i rutan méarkt variables: klicka en gang pa raden
markt C1 y och darefter pa (det fungerar ocksa att dubbelklicka pa c1 y).

Display Descriptive Statistics r‘s__<|
1oy Yariables:
ol

By watiables {optional):

4 Skatiskics. .. | Graphs... |
Help o | Cancel |

For att bestdamma vilka statistiska matt man vill berdkna kan man klicka pa for att
fa upp menyn




Display Descriptive Statistics - Statistics

W HMean; [ Trimmed mean [W [ nonmissing
[ SE of mean [ Sum [ M missing

[v Standard deviation [ Minimum [ M total

[ Wariance [~ Maximurm [ Cumulative M
I Coefficient of wariation [ Range [ Percent

[ Cumulative percent

| First quartile [ Sum of squares  —heck statistics
[ Median [ skewness ~ Default

[ Third quartile [ Kurtosis * Mone

[ Interguartile range [~ M350 = al

[ Mode

Help oK | Cancel |

| det har fallet valjer vi att kryssa for Mean (medelvérde), Standard deviation (standardavvi-
kelse) och N nonmissing (antalet observationer som inte har saknat vérde). Tryck nar du
ar nojd.

For att fa olika typer av figurer som beskriver datamaterialet skall man vélja [Graphs... . |
detta fall vill vi ha en ”Individual value plot” och markerar darfor enligt

Display Descriptive Statistics - Graphs E|

[ Histogram of data

[ Histogram of data, with normal curve
v Individual value plat:

[ Boxplot of data

Help (o] Cancel

och trycker pa [ OK |. Valj sedan och studera resultatet. | resultatfonstret star nu bland
annat

Descriptive Statistics: y

Variable N Mean StDev
y 5 7.960 1.428

Under rubrikerna Mean resp. StDev (= Standard Deviation) star resultaten, 7.960 resp.
1.428. Man far ocksa ett grafiskt fonster som ser ut enligt



Individual Value Plot of y

T T T T T
6 7 8 9 10
y

Figuren hamnar alltsa i ett eget fonster och kan redigeras. u

Det finns alltsa tre typer av fonster, Session som har "efternamnet” . TXT, Worksheet med
"efternamnet™ _.MTW och Graphs med "efternamnet™ .MGF. Dessutom kan hela projektet spa-
ras med namnet . MPJ.

2. Inldsning av observationerna

D& man har samlat in observationerna och skall anvanda en dator for att halla reda pa eller
analysera datamaterialet bor detta struktureras pa ett satt som gor att det fortsatta arbetet blir
sa enkelt som majligt. Trots att det finns manga olika datorprogram for statistisk bearbetning
géller i stort sett generella regler for hur datamaterialet bor vara upplagt. Det &r darfor klokt
att redan fran borjan anvanda dessa regler.

Materialet lases in i en matris, dar raderna (“horisontellt") &r observationer och kolum-
nerna (“vertikalt") ar vardena pa en av variablerna. Detta stt att lagga in observationerna gor
det enkelt att 14gga till nya observationer efterhand som de kommer in.

Variabel 1  Variabel 2 Variabel 3
\’ d )

Observation 1 —»

Observation 2 —»

Observation 3 —»

Exempel 2. Skolklass

Ur en skolklass har samlats in ett stickprov med fem elever dar namn, kon, alder och vikt har
registrerats. Datamaterialet kan beskrivas av en matris med fem rader och fyra kolumner, och
dar ytterligare en rad har lagts in for att ange variabelnamnen.



NAMN KON ALDER VIKT
Lisa F 6 20
Stina F 7 25
Lars M 6 17
Peter M 8 30
Anna F 7 27

(Har har de svenska variabelnamnen anvants, men de engelska ar ibland att foredra eftersom
vissa program inte accepterar a, 4 och 6.) [ |

Nar forsoken upprepas kan ocksa en eller flera variabler anvandas till att dela in observa-
tionerna i olika grupper. | féljande exempel ar behandlingen och veckan variabler som delar
datamaterialet i grupper.

Exempel 3. Purjolok
Vid ett forsok som syftar till att undersdka hur kvaveinnehallet forandras i purjolok har man
gjort ett forsok dar man jamfor ett ogodslat falt med ett som innehallit perserklGver/havre.
Purjolokens torrsubstansvikt i kg/ha samt kvéaveinnehallet i procent av torrsubstansen har
matts pa tre platser per behandling och matningen har upprepats 7 och 11 veckor efter plan-
teringen.

For att forenkla inlasningen kvantifieras forst behandlingen enligt

0 = ogddslat
{1 = perserklover / havre

For att sedan fa den ratta dverblicken och latt kunna fa ut resultat ur ett statistiskt pro-

grampaket bor forsoksresultatet skrivas enligt tabellen.

Om man vill l&sa in nya variabler fran ett annat problem sa kan man fortsatta pa samma
ark och lagga in dem fran c2 om man redan har ndgot i C1, men man kan ocksa skapa ett nytt
datafonster genom att valja

File » New ...
for att ha battre ordning pa de olika forsoken. Har skapar vi ett nytt datafénster som far nam-
net Exempel 3.

7 | Exempel 3 ***

4 c1 ] a 4 (5]
week treat dry N
232 263
161 290
148 293
366 354
218 330
257 285
1633 153
213 190
972 "
2560 258
2430 *
855

~— -~ oo =~~~ ~oaoao




Saknade varden har hér betecknats med en asterisk, och detta ar "missing value code" i Mini-
tab. I andra program anvénds andra tecken, SAS anvénder t.ex. punkt. Det &r ibland de sak-
nade véardena som forsvarar éverforingar mellan olika programpaket. [ |

3. Minitab tillsammans med Word och Excel

3.1. Fran Excel till Minitab

For att flytta datamaterial fran Excel till Minitab ar det viktigt att komma ihag hur data skall
lasas in. GOr man detta som i foregaende avsnitt, har man ett rektanguléart schema dar obser-
vationerna &r i rader och variablerna i kolumner. Det &r viktigt att komma ihag att inte Ex-
celarket far innehalla insprangda delmedelvarden och delstandardavvikelser; det ar alltfor
manga som har upptackt att det &r ett stort arbete att fa bort dessa.

Det &r ofta att foredra att man l&ser in storre datamaterialet i Excel eftersom detta program
for det mesta har nagot béttre editeringsmojligheter.

Exempel 2 (forts). Skolklass
For att lasa in data pa skolbarnen i Excel gér man ett blad enligt

A B C D E
1 namn kiin alder wikt
2 |Lisa F [ 20
3 |Stina F Fi 25
4 |Lars fl 5 17
5 |Peter vl 3 a0
B | Anna F 7 27

Man kan nu valja att 6ppna ett sparat Excelark direkt i Minitab, men ar det sma dataméang-
der ar det oftast lattare att klippa ut och Klistra in det direkt i Minitab.

For att klistra in markeras alla observationerna, inklusive variabelnamnen och man valjer
kopiera. Ga over till Minitab och stall dig i den rad som skall innehalla variabelnamnen (har
lagger vi in ocksa dessa data i ett nytt datafonster). Klistra nu in datamaterialet i datafonstret.
De variabler som inte innehaller siffror blir text-kolumner och far namnet C1-T resp C2-T.

+ C1-T 2T 3 C4 Ch (
namn kin alder vikt
1 |Lisa F B 20
2 |Stina F 7 26
3 Lars Il 5} 17
4 |Peter I g 30
5 Anna F 7 e
B  —
Nu kan man arbeta vidare med detta material i Minitab. [ |



Lagg speciellt méarke till att ett valdigt vanligt skal till att man helt plotsligt har fatt en kolumn
betecknad med "T” kan bero pa att man har matat in decimalkomma istéllet for decimalpunkt
(eller tvartom beroende pa hur programmet ar installt).

3.2. Fran Minitab till Word

De resultat som erhalls i resultatfonstret eller i en graf kan skrivas ut direkt pa skrivaren ge-
nom att man staller sig i det fonster man vill skriva ut och valjer att skriva ut det. Da far man
utskriften i A4-format, och ofta vill man lagga in resultaten i ett dokument sa som har gjorts i
exemplet ovan.

For att Overfora en del av ett resultatfonster till Word markerar man den text som skall
flyttas och kopierar eller klipper ut den pa vanligt sétt. Sedan gar man 6ver till sitt Word-do-
kument utan att stdnga Minitab och klistrar in texten.

Det ar en bra 6vning att ta det tidigare resultatet, flytta éver det i Word och se att texten
blir likadan som i Minitab. Word behaller allts& de formateringar som finns i resultatfonstret?.

Fonster med figurer ("Graph Window") ar enklare att kopiera, det &r bara att flytta sig till
det grafiska fonster man vill kopiera och sedan ga 6ver till Word och klistra in det. Har kan
man det ofta vara bra att vélja ”Klistra in special...” och sedan ”Bild” om man inte vill ha
kvar kopplingen till Minitab.

3.3. Lasa in data i Minitab

Det finns ett tillfalle d Minitab kan vara att foredra nar man skall l&sa in data, och detta &r
nar man har vérden som upprepas enligt ett regelbundet monster. Som exempel véljer vi det
tidigare exemplet med kvaveinnehallet i purjolok.

Exempel 3 (forts). Purjolok
Hér skall vi lasa in en kolumn med sex stycken 7 foljt av sex stycken 11 samt en kolumn med
tre 0 foljt av tre 1 upprepat tva ganger. Detta gors genom att vélja
Calc » Make Patterned Data » Simple Set of Numbers...
For att astadkomma den forsta kolumnen valjs

Simple Set of Numbers @

Store patterned data in: | week

From First walue: |7
To last value: 11
In steps of: 4

Murber of times ta list each value: 3
Humber of times to list the sequence: | 1|

Help [o]4 | Cancel |

? Resultatfonstret anvander teckensnittet Courier som tar lika stor plats for alla bokstaver. Detta gor att man inte
behdver anvanda tabbar utan det racker att rakna blanksteg for att fa raka marginaler.



For att géra kolumnen med 0 och 1 upprepad tva ganger valjs aterigen

Calc » Make Patterned Data » Simple Set of Numbers...

Store patterned data ind | breat

Erom first value: | g
Tolast value: 1
In steps aof: 1

Mumber of times o lisk each value: 3
Murnber of times to list the sequence: | 2|

N
Help oK Cancel |
(Tank sjalv efter (eller prova) att detta ger den 6nskade kolumnen.) [ |

3.4. Editera Session Window 1 Minitab

Om man bara vill ha ut ett enskilt resultat ur resultatfonstret upptacker man att resultaten
laggs efter varandra da man gor flera analyser. Det ar dock latt att radera de utskrifter man
inte vill ha ut pa papperet. Om man vill undvika att av misstag sudda ut saker i fonstret kan
man ga till "read-only™ genom att markera

Editor » Qutput Editable
nar man har markdren i resultatfonstret®.

3.5. Editera Worksheet i Minitab

Andra namn p& Worksheet

Det ar valdigt bra att kunna ge namn pa olika datafonster for att lattare hitta nar man soker
efter ett fonster under menyn window. Detta gér man genom att klicka pa Project Manager och
sedan ge namn genom att klicka i filstrukturen pa samma sétt som man gor i Windows for
ovrigt.

Kopiera delar av kolumner

Ibland vill man kanske ha ut en del av en kolumn. I exemplet med purjolék kanske man vill
undersoka de I6kar som &r sju veckor gamla.

Exempel 3 (forts). Purjolok
For att kopiera de skorderesultat som hor till sju veckor gamla lokar till ett nytt datafonster
valjer man

Data » Subset Worksheet...

% Lagg marke till att innehallet och menyerna férandras beroende pé vilken typ av fénster man &r i.



och fyller i de varden som man vill ha. Har finns ett alternativ som heter Brushed rows, och
med detta menas att man i en bild kan markera de observationer som man tycker skall vara
med. Man kan ocksa anvanda

Data » Copy » Columns to Columns...
for att kopiera delar av datamaterial till nya kolumner eller datafonster. [ |

Anvanda matematiska funktioner

Ibland vill man transformera observationerna eller anvanda en funktion som inte finns till-
géanglig bland menyerna. Om man till exempel vill logaritmera vérdena gor man detta genom
att anvanda

Calc » Calculator ...

Exempel 1 (forts). Inledande exempel
| detta exempel har vi tidigare berdknat medelvarde och standardavvikelse, och man kan
ocksa fa fram variansen. For att exemplifiera anvander vi trots allt har de matematiska
funktionerna for att berdkna denna. Vilj
Calc » Calculator ...

och om svaret skall skrivas i en kolumn som far namnet varians sa fyller du i enligt (** be-
tecknar "upphojt till" i Minitab)

FEC storeresubinvariable: [varans

Expression:
STDEW"'1**2
Funckions:
ﬂﬂﬂ ﬂ jJ |.C\II Functions ﬂ
e Vo

HJM ﬂ And Word

ﬂ wWorkdays “

ﬂ ﬂ M Select

STDEYWnumber)

™ Assign as a Formula

Help Qi | Zancel |

Lagg marke till att man kan skriva det variabelnamn som man vill ha direkt i rutan, men
lagg ocksa marke till att Minitab skriver 6ver utan att varna om man véljer ett variabelnamn
som redan finns i datafonstret.

Om man bara vill transformera observationerna i en kolumn eller lagga ihop tva kolumner
sd dr detta ocksa enkelt gjort. Med det som har beskrivits ovan borde detta ga att gora utan
stOrre besvar. [ |




4. Beskrivande statistik

4.1. Numeriska metoder

For att undersoka hur skorden forandras fran den sjunde till elfte veckan kan man gora lite
numeriska matt for att fa en uppfattning om detta. Har bryr vi oss inte om att de olika I6karna
har fatt olika behandling, syftet ar ju bara att exemplifiera.

Exempel 3 (forts). Purjolok
De beskrivande matten erhalls genom att man véljer
Stat » Basic Statistics » Display Descriptive Statistics...

Display Descriptive Statistics E|
C1 week Yariables:
C2  freat d
C3 dry "
4 N

By wariables {optional):

week

Q Statistics... | Graphs. .. ‘
Help [0]4 Cancel ‘

Resultatet blir (Minitab minns vad som gjordes sist, s& om inte rutan som begarde "Individual
value plot” har avmarkerats sd kommer det aterigen en sadan och du far samma beskrivande

matt som du tidigare valde med [Statistics...|)

Descriptive Statistics: dry

Variable week N Mean StDev
dry 7 6 230.7 79.3
11 6 1777 741

Man kunde ju ha valt en hel del andra beskrivande matt. Har féljer en forklaring till nagra
av dessa olika matt:

N anger antalet observationer som anvands i rakningen.

N* anger antalet observationer som har "missing value" (kodade med *), men finns ej har.

Mean &r det vanliga aritmetiska medelvardet. Torrvikten ar givetvis hogre efter elva
veckor.

Median ar som vanligt det "mittersta” vardet, eller medelvardet av de tva mittersta om det
ar ett jamnt antal vérden.

10



Tr Mean, ar "trimmed mean" dar man har tagit bort ett antal stora resp. sma varden och
darefter berdknat medelvardet. Detta for att inte s.k. "outliers" skall fa for stor betydelse i me-
delvérdesberdkningen. Minitab tar bort 5% av de storsta och 5% av de minsta vardena nér
detta medelvarde beréknas.

StDev ar den vanliga standardavvikelsen. Det &r betydligt storre spridning bland de &ldre
Iokarna.

SE Mean ar Standard Error eller medelfel. Det ar helt enkelt StDev/~/N och detta uttryck
ar i vissa sammanhang mer anvéndbart dn standardavvikelsen.

Min och Max &r minimum och maximum och behdver inte forklaras ytterligare.

Q1 och Q3 ar de bdgge kvartilerna. Kvartil innebar att man lagger observationerna i stor-
leksordning och darefter delar dem i fyra delar. De tre punkter som da delar materialet &r
nedre kvartilen, medianen och 6vre kvartilen. Kvartilerna illustreras tydligare i avsnittet om
Boxplot.

4.2. Boxplot

En mycket illustrativ grafisk presentation av medianen och kvartilerna ges av en s.k Boxplot
(eller Box-and-Whisker-plot, kallas pa svenska ibland Ladagram). Denna far man enkelt ge-
nom att vélja

Stat » Basic Statistics » Display Descriptive Statistics...

Vilj sedan [ Graphs... . och markera rutan "Boxplot of data".

Tryck [ OK ]sa erhalls figuren

Boxplot of dry

2500

2000

1500 1

dry

1000 A

500 -

—_—

7 11
week

| figuren ar strecket inne i ladan medianen, den undre ladkanten ar nedre kvartilen och den
ovre ladkanten &r évre kvartilen.

11



4.3. Scatterplot

Ibland har man tvadimensionella variabler som man vill rita upp mot varandra for att se om
det finns ndgot samband. Den figur man far ur Minitab kan forbattras avsevart om man har tid
och lust till detta. Hur detta gar till Iamnas dock at lasaren.

Exempel 2 (forts). Skolklass

For att rita variabeln vikt mot alder i en scatterplot (det finns inget bra svenskt namn) anvands
Graph » ScatterPlot...

och sedan valjer man den formarkerade rutan Simple. Fyll sedan i enligt

Scatterplot - Simple E|

c3 S!der ¥ variables | X variables | &

C4 vkt 1 wikk Alder
2
3
4
5
b
T W

acale... | Labels... ‘ Data Wiew, ..
Multiple Graphs. .. | Data Options... ‘
Help [8]4 ‘ Cancel

Tryck pd[ OK ], och resultatet blir

Scatterplot of vikt vs alder
30 °
284
°
26+
°
24
b
>
22
204 e
184
°
16_ T T T T T
6.0 6.5 7.0 7.5 8.0
alder

Genom att valja de olika optioner som finns kan man dndra utseende och skalor pa
figuren, och man kan ocksa editera figuren. Detta lamnas dock till lasaren, men ett exempel
pa hur figuren kan forandras foljer har:

12



Barnens vikt och alder
35+
30+ X
X
A~ i x
N 25
20+ X
X
15 T T T
6 7 8
alder

4.4, Histogram

Histogram &r lika enkelt som att gora andra figurer, bara man vet var man skall letal Som ett
exempel kontrollerar vi om slumptalsgeneratorn i Minitab ger varden som man kan tro &r nor-
malfordelade. Slumptal fran normalférdelningen med populationsmedelvérde 0 och standard-
avvikelse 1 far man genom att vélja

Calc » Random Data » Normal...
Normal Distribution E|

Mumber of rows of data to generate: | 1000

Store in columnis):

rannar

Mean: [ g.o

Standard dewiation: 1.0|

Help (0] 4 Cancel |

Nu har datorn slumpat 1000 observationer av en normalférdelning med populationsmedel-
varde 0 och standardavvikelse 1 och lagt dessa varden i variabeln med namnet rannor. Fér

att rita ett histogram 6ver dessa varden kan man som tidigare ga via menyn for deskriptiv
statistik men vi valjer héar en annan vag som ger fler mojligheter att paverka utseendet pa figu-
ren (samma sak géller for dvrigt den Boxplot som vi gjorde tidigare):

Graph » Histogram...
Och Vélj simple. | rutan Graph variables: valjs rannor.

Tryck pa[ OK |.
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Ett exempel pa ett histogram av denna typ finns nedan, men eftersom det ar slumptal som
ar uppritade kommer utseendet att variera fran gang till gang. En viss klockform borde man ju
dock alltid fa.

Histogram of rannor

904 T —

80

70+ —

60+

504 —

Frequency

40-

30

20

104

T
-2.4 -1.6 -0.8 0.0 0.8 1.6 2.4
rannor

5. Statistiska metoder for ett stickprov

| de allra flesta fall skall man vid analysen jamféra tva eller flera olika behandlingar. Ibland
kan man dock ha ett stickprov som man vill uttala sig om, och det &r i den dndan denna be-
skrivning borjar.

Né&r man skall gora analyserna nedan &r det viktigt att vardena utgor ett s.k. slumpmassigt
stickprov, dvs. att vardena dr oberoende av varandra.

5.1. Normalférdelning och ett stickprov

For det mesta antar man att stickprovet kommer fran en normalfordelning, eller atminstone att
det ar ungefar normalfordelat. Detta innebar att om man samlar in manga observationer och
ritar ett histogram sa skall detta fa formen av den berémda klock-kurvan. Baserat pa ett stick-
prov som man antar & normalférdelat kan man antingen goéra ett hypotestest eller ett konfi-
densintervall for populationsmedelvardet. Detta gors mycket enkelt i Minitab, det enda man
skall bestamma &r om (populations-)standardavvikelsen &r kénd eller skall skattas ur det
stickprov man har. | praktiken ar det ju mycket ovanligt att standardavvikelsen &r kédnd och
darfor behandlas hér endast fallet med oké&nd standardavvikelse.

Exempel 4. Ett stickprov
Testa om stickprovet med vérdena 33.5, 32.0, 32.5, 36.5 kan komma fran en population med
medelvardet 30. Dessa varden antas inlasta i en kolumn med namnet onesamp.
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Nollhypotesen i detta fall ar att populationsmedelvérdet & 30 medan mothypotesen &r att
populationsmedelvérdet inte ar 30. Valj

Stat » Basic Statistics » 1-Sample t... (1-Sample Z... da standardavvikelsen &r kand)
1-Sample t (Test and Confidence Interval) g|

{* Samples in columns:

onesamp

™ Summarized data

1

[ Perform hypothesis test

Hypothesized mean: | 30

Graphs... | Options... |
Help

For att eventuellt &ndra mothypotesen eller konfidensgraden anvénder man rutan
[ Options... | men i detta fall &r det ratt installt, not equal &r ju precis vad man vill ha som
mothypotes. Resultatet i resultatfonstret blir

I

K Cancel |

One-Sample T: onesamp

Test of mu = 30 vs not = 30

Variable N Mean StDev SE Mean 95% CI T P
onesamp 4 33.6250 2.0156 1.0078 (30.4178; 36.8322) 3.60 0.037

Det mest intressanta vardet har & P som ar 0.037. Detta sa kallade p-vérdet anger om hypote-
sen kan forkastas eller ej, och den vanligaste "regeln” &r att forkasta nollhypotesen om p-vér-
det &r mindre an 0.05. | detta fall kan vi alltsa forkasta nollhypotesen, vilket pa vanlig svenska
betyder att vi har anledning att misstdnka att populationsmedelvardet inte & 30. Som vanligt i
statistiken kan vi dock inte vara helt sékra; vi har valt nivan sa att man i 1 fall av 20 forkastar
nollhypotesen dven om den &r sann. [ |

Det man oftast ser ar hypotestest som har beskrivits ovan, men hypotestest Kkritiseras
ibland. Man kan da istéllet anvanda sig av konfidensintervall. Ett konfidensintervall med 95%
konfidensgrad har erhallits automatiskt ovan som (30.42, 36.83), och om man vill &ndra kon-
fidensgraden sa kan man vélja[Options..]. Konfidensgraden 95% séger att konfidensintervallet
har egenskapen att det med 95% sannolikhet (dvs. i 19 fall av 20) tacker det ratta vardet pa
populationsmedelvérdet.
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Ju smalare intervallet &r, ju béattre ar det givetvis. Ett smalt intervall far man antingen om
man har manga observationer i stickprovet (och det kan man kanske paverka sjalv) eller ge-
nom att spridningen mellan vardena ar liten (och det ar ju svart att paverka). | exemplet ovan
ar intervallet kanske for brett for att vara praktiskt anvandbart.

En foérutsattning for att testet och konfidensintervallet ovan skall vara giltigt ar att popula-
tionen ar normalfordelad. Ett satt att kontrollera detta &r att anvanda s.k. normalfoérdelnings-
papper. Fore datorernas tidevarv var detta nagot av det mest tidsodande man kunde sysselsatta
sig med inom statistiken, nu ar det mycket enkelt.

Normalférdelningspapper

Ett normalférdelningspapper ar sa listigt ordnat att man har andrat skalan pa y-axeln sa att nar
stickprovet fran en normalférdelning ritas upp sa skall de utgdra en rat linje. Nar man sedan
gor test om huruvida de ligger intill linjen utnyttjar man asymptotiska resultat, dvs. resultat
som bara galler om man har manga observationer. Vi anvander det tidigare materialet med
1000 normalférdelade observationer som fanns i samband med histogrammet.

Materialet ar redan inlast och finns i variabel rannor. Valj

Stat » Basic Statistics » Normality test ...

Varizble: | rannor

Percentile Lines
{(* Mone
 At¥vales: |

(" At data values: |

Tests for Normality
{* Anderson-Darling
" Ryan-Joiner (Similar to Shapira-wilk)

" Kolmogorov-Smirnoy

Title: |Test av normalfordelning
Help oK Cancel

Resultatet i detta fall blir:

Test av normalfordelning
Normal

99.99

Mean -0.0008431
StDev 0.9671
N 1000
99+ AD 0376

P-Value 0.412
95 1

804

504

Percent

204

rannor
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P-vardet (P-value) ger en fingervisning om hur man skall stalla sig till hypotesen om normal-
fordelning hos populationen. Ett varde under 0.05 gor att man forkastar hypotesen att popula-
tionen &r normalférdelad, och ett vérdet 6ver 0.05 gor att man inte kan forkasta hypotesen.
Detta brukar innebéra att man fortsatter arbeta som om populationen var normalférdelad.
Lagg dock marke till att man pa intet satt har bevisat detta, man anvander bara principen att
tro pa normalfordelningen tills nagon annan bevisar motsatsen. | detta fallet forkastar vi inte
hypotesen, och det stammer ju val med att data var simulerade fran en normalférdelning. ™

Om man nu inte kan anta att populationen ar normalfordelad har man tva alternativ:
1. Om man har manga observationer i stickprovet brukar det fungera i alla fall.
2. Anvand en icke-parametrisk metod som inte forutsatter normalférdelad population.

5.2. Ej normalférdelning och ett stickprov

Icke-parametriska test heter pa engelska "non-parametric tests" och darfor finns de testen un-
der menyn nonparametrics. | fallet med ett stickprov finns det tva olika test, och det &r vart att
notera att icke-parametriska test inte testar medelvéardet utan medianen. Att testa om popula-
tionen har medianen 30 &r detsamma som att undersoka om halften av populationen har vér-
den under 30 och den andra halften har varden 6ver 30.

Teckentest

Teckentestet (eng. sign test) ar mycket latt att forstd men tyvarr inte s effektivt. 1dén ar helt
enkelt att om medianen &ar 30 s& borde ungefar halften av stickprovets vérdet vara under 30
och resten vara 6ver 30. Har man exempelvis 20 varden i stickprovet och alla 20 &r under 30
ar det ganska svart att tro att medianen ar 30.

Exempel 4 (forts). Ett stickprov
For att avgdra om medianen &r 30 med ett hypotestest, vélj
Stat » Nonparametrics » 1-Sample Sign...

och fyll i att du vill testa om medianen &r 30.
1-Sample Sign E‘

Yariables:

onesamp

" Confidence interval

Help

(v Test median: 30
Alternative: Im

Cancel
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Utskriften i resultatfonstret blir

Sign Test for Median: onesamp

Sign test of median = 30.00 versus not = 30.00

N Below Equal Above P Median
onesamp 4 0 0 4 0.1250 33.00

Trots att alla vardena &r dver 30 kan man inte forkasta hypotesen (p-vardet 0.1250 ar ju storre
an 0.05). Teckentestet ar alltsa inte tillrackligt effektivt i detta fall. [ |

Wilcoxon's tecken-rang-test
Detta test ar mer effektivt eftersom det ocksa utnyttjar storleken pa vardena, men man har har

ocksa kravet att populationen skall ha en symmetrisk fordelning. Detta leder ju dessutom till
att medianen och populationsmedelvérdet sammanfaller.

Exempel 4 (forts). Ett stickprov
For att gora testa om medianen ar 30, valj

Stat » Nonparametrics » 1-Sample Wilcoxon...

x)

1-Sample Wilcoxon

Variables:

onesamp

i~ Confidence interval

* Testmedian: 30|
Alternative:  |not equal -

Help oK Cancel

Wilcoxon Signed Rank Test: onesamp

Test of median = 30.00 versus median not = 30.00

N
for Wi lcoxon Estimated
N Test Statistic P Median
onesamp 4 4 10.0 0.100 33.25

Inte heller har kan man foérkasta hypotesen dven om p-vardet har dr nagot mindre an i tecken-
testet. |

Exemplet har gett det resultat man brukar fd. Om man kan, skall man anvénda testet som
bygger pa normalfordelning eftersom det &r mest effektivt.
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Det finns ytterligare ett skél till att ibland anvanda ett icke-parametriskt test. Skalet ar att
detta test ar mer robust mot "daliga varden". Om man av misstag har rakat lasa in 365 istallet
for 36.5 sa kommer p-vardet vid normalférdelningsantagandet att andras till 0.38. Det kanske
forvanar att testet nu inte langre kunde forkasta nollhypotesen nar man flyttade ett véarde dnnu
langre ifran 30, men anledningen &r att man genom att hoja vardet ocksa okade pa den skat-
tade standardavvikelsen ordentligt. Gor man teckentestet eller Wilcoxon's test med detta
varde kommer inte p-vardet att forandras alls!

6. Statistiska metoder for tva stickprov

Som namnts tidigare ar det vanligaste att man med en statistisk metod skall jamfora tva eller
flera populationer. | det forra avsnittet var ett av huvudresultaten att om man antog att det var
en normalfordelad population sa kunde man anvénda ett "battre” test &n om man inte kunde
gora detta antagande. | fallet med tva stickprov galler precis samma sak, om man har normal-
fordelning hamnar man i det berémda t-testet.

6.1. Normalfordelning och tva stickprov

Om man antar att de tva populationer man skall jamféra ar normalfordelade, finns det bara tva
parametrar som skiljer populationerna at, populationsmedelvardet och standardavvikelsen.
Saker och ting blir annu trevligare om man dessutom kan anta att standardavvikelserna ar de-
samma i de bada populationerna. Att testa om populationsmedelvérdena &r desamma &r ju da
detsamma som att testa om de tva stickproven ar hamtade fran precis samma population. Det
finns ocksa ett annat skal till att man ofta antar att standardavvikelserna ar desamma: det blir
teoretiskt mycket enklare att rakna i den situationen & om man har olika standardavvikelser. |
ett datorprogram spelar det ingen roll om man har lika eller olika standardavvikelse, men man
skall ha i minnet att lika standardavvikelser och normalférdelning innebér att man testar om
de bada populationerna &r lika.

Man kan ocksd gora konfidensintervall for skillnaden mellan populationernas popula-
tionsmedelvarden. Har brukar man framst titta om intervallet "omsluter” 0, i sa fall & namli-
gen inte populationsmedelvérdena signifikant skilda at.

Exempel 5. Tva stickprov
Testa om stickproven 33.5, 32.0, 32.5, 36.5 respektive 39.5, 36.0, 34.5, 36.5 kan komma fran
populationer med samma populationsmedelvarde.

Nollhypotesen i detta fall &r att populationsmedelvérdena &r desamma, mothypotesen ar
att populationsmedelvardet &r olika. Valj

Stat » Basic Statistics » 2-Sample t...
Nu hamnar man i en valsituation, antingen skall man markera att vardena ar inlésta i en ko-
lumn (Samples in one column) eller att vardena &r inlasta i tva kolumner (Samples in different
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columns). Om man laser in data enligt de regler som angivits i tidigare kapitel sa har man en
kolumn, men man har ocksa en kolumn som anger vilket stickprov den méatningen kommer
ifran. Datamaterialet ser da ut som till vanster, medan olika kolumner blir som till hoger.

result
33.5
32.0
325
36.5
39.5
36.0
34.5
36.5

grupp

N NDNDNPFPEFP PP

grupp 1 : grupp 2
33.5 39.5
32.0 36.0
32.5 34.5
36.5 36.5

Har valjer vi att exemplifiera den forsta varianten, och da véljer man

=N
Help

2-Sample t (Test and Confidence Interval)

(¢ Samples in one column

resultat
Subscripts: | grupp

{(— Samples in different columns

——
—

{~ Summarized data

Samples:

X

Options... |

Cancel |

Den alternativa hypotesen liksom nivan kan éndras genom att valjal Options.... | den ne-
dersta rutan kan man sedan vélja om man vill att standardavvikelserna (varianserna) skall vara

lika eller inte. Om man har valt att anta lika varians blir utskriften

Two-Sample T-Test and CI: result; grupp

Two-sample T for result

grupp N Mean StDev SE Mean
1 4 33.63 2.02 1.0
2 4 36.63 2.10 1.0

Difference = mu (1) - mu (2)
Estimate for difference:
95% CI for difference:
T-Test of difference =
Both use Pooled StDev = 2.0565

-3.00000
(-6.55820; 0.55820)
0 (vs not =): T-Value =

20
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De "svara" delarna av utskriften &r raden med T-test. Det mest intressanta brukar vara p-
vardet 0.085, som visar att man inte kan forkasta hypotesen att stickproven har samma popu-
lationsmedelvérde. Vardet pa T ar en teststorhet som inte har sa stor betydelse och man har
inte heller nagon storre nytta av DF. Eftersom man har antagit att varianserna (och darmed
standardavvikelserna) ar lika® s far man ocksd en skattning av denna gemensamma
standardavvikelse, och i detta fall & den 2.06. Har blir den precis medelvérdet av de bada
stickprovens standardavvikelser, men det ar bara en slump. Den "poolade" standardavvikelsen
berdknas enligt en nagot mer komplicerad formel. Lagg ocksa marke till att konfidensinter-
vallet tacker 0, vilket &r ytterligare en indikation pa att hypotesen om lika populationsmedel-
varden inte kan forkastas. u

Det gar ocksa att gora ett test for om varianserna verkligen &r lika, och detta behandlas i
det foljande avsnittet.

6.2. Test av lika varians

Exempel 5 (forts). Tva stickprov
Testa om stickproven 33.5, 32.0, 32.5, 36.5 respektive 39.5, 36.0, 34.5, 36.5 kan komma fran
populationer med samma varians.

Nollhypotesen i detta fallet &r att varianserna ar desamma, mothypotesen &r att varianserna
ar olika. Vlj

Stat » ANOVA » Test for Equal Variances...
(Har man bara tva olika grupper kan man ocksa anvanda

Stat » Basic Statistics » 2 Variances...
men det fungerar inte med fler grupper.)
Med mer an tva grupper maste nu vardena vara inlésta i en enda lang kolumn och samtidigt ha
en kolumn som anger vilket stickprov méatningen kommer ifrdn. Med grupp och result

som tidigare i exemplet sa skall det vara
Test for Equal Yariances E]

Response: | resul

Factaors: grupp

Confidence level: 05,0

Title:

Storage. ..
Help oK Cancel |

* Det 4r lite konstigt att Minitab har forinstéllt s& att man inte antar att varianserna &r lika; det vanligaste &r
nadmligen att man har antagit att varianserna ar lika nar man gor ett t-test.

21



Nar man kor proceduren far man dels en utskrift i resultatfonstret, dels en figur. Resultat-
fonstret blir

Test for Equal Variances: result versus grupp

95% Bonferroni confidence intervals for standard deviations
grupp N Lower StDev Upper

1 4 1.05929 2.01556 9.54568
2 4 1.10190 2.09662 9.92958

F-Test (normal distribution)
Test statistic = 0.92; p-value = 0.950

Levene®"s Test (any continuous distribution)
Test statistic = 0.00; p-value = 1.000

Har far man tva p-vérden, ett som ar ett F-test (med mer an tva grupper sa kallas detta
Bartlett’s test) som man anvander vid normalférdelning, och ett som heter Levene's test och
kan acceptera lite avvikelser fran normalférdelning. Bada vardena ar klart éver 0.05, och man
kan darfor inte forkasta nollhypotesen att varianserna (standardavvikelserna) &r lika. Figuren
ger ocksa en grafisk illustration av varianserna i de olika grupperna.

Test for Equal Variances for resultat
F-Test
Test Statistic 0.92

1 t * i P-Value 0.950
§ Levene's Test
5 Test Statistic 0.00

P-Value 1.000
24 t . i
T T T T T T
0 2 4 6 8 10
95% Bonferroni Confidence Intervals for StDevs

q —
Q
Q
3
c
[=2]

2 — | -

T T T T T T T T
32 33 34 35 36 37 38 39
resultat

Lagg marke till att detta test inte &r begransat till tva stickprov utan kan anvandas ocksa da
man jamfor mer an tva stickprov. DA ersatts emellertid F-testet med Bartlett's test, men detta
behandlas inte i avsnittet med mer &n tva stickprov. [ |

6.3. Ej normalférdelning och tva stickprov

Det test man &r hanvisad till i Minitab kallas Mann-Whitney's test. Nar man skall genomféra
detta testet upptacker man att Minitab ar inkonsekvent nar det galler inldsning av data. Har
skall man namligen lasa in de tva stickproven i olika kolumner, metoden med en kolumn fun-
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gerar inte har! Har man last in data i en enda lang kolumn kan man dock ganska enkelt dela
upp det i tva kolumner genom att anvanda

Data » Unstack Columns...

Exempel 5 (forts). Tva stickprov
Testa om stickproven 33.5, 32.0, 32.5, 36.5 respektive 39.5, 36.0, 34.5, 36.5 kan komma fran
populationer med samma median.

Nollhypotesen &r i detta fall att medianerna ar desamma, mothypotesen &r att medianerna
ar olika. Valj

Stat » Nonparametrics » Mann-Whitnei...

C1 grupp 1 First Sample: ‘grupp 1'
C2  grupp 2
Second Sample: | 'grupp 2

Confidence level: as5.g

Alternative: lm

Help oK | Cancel

Andra eventuellt hypoteser och signifikansniva.

Mann-Whitney Test and CI: grupp 1; grupp 2

N Median
grupp 1 4 33.000
grupp 2 4 36.250

Point estimate for ETA1-ETA2 is -3.000

97.0 Percent Cl for ETA1-ETA2 is (-7.501;2.001)

W =12.5

Test of ETALl = ETA2 vs ETAl not = ETA2 is significant at 0.1489
The test is significant at 0.1465 (adjusted for ties)

Har far man ut tva stycken p-varden, 0.1489 resp 0.1465 (adjusted for ties). Det senare bety-
der att man har modifierat testet nagot eftersom det innehaller tva eller flera varden som é&r
lika (="ties"); det finns ju tva varden som ar 36.5. Har far man det lite konstiga pastaendet att
testet ar signifikant pa nivan 0.1465, men det innebar ju att man inte kan pasta att det finns
nagon skillnad mellan populationernas medianer eftersom 0.1465>0.05. [ |

Precis som fallet var vid ett stickprov ar det sa att man forlorar lite om man anvander
Mann-Whitney's test om man i sjalva verket har forutsattningar att gora ett t-test.
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7. Statistiska metoder vid flera stickprov

Den allra vanligaste metoden i statistiken ar att gora en variansanalys. Detta kallas ofta
ANOVA efter engelskans Analysis of Variance. Variansanalysen i sin "standardform” forut-
satter emellertid helst bade normalfordelning och att det & samma varians i alla populatio-
nerna. Det dr ocksa viktigt att komma ihag att det trots namnet inte &r varianser man testar,
det &r populationsmedelvérdena som testas genom att man jamfor variansskattningar.

7.1. Normalfordelning och flera stickprov

Variansanalys &r en utveckling av t-testet, dar man istéllet for tva stickprov har fler stickprov.
Variansanalysen kan sedan utvecklas i en mangd olika riktningar, men har behandlas bara de
mest grundldggande problemen.

Exempel 6. Flera stickprov
Man har fyra stickprov, och man vill undersdka om dessa har samma populationsmedelvarde.
Det finns skal att tro att alla stickproven kommer fran normalférdelade populationer med
samma standardavvikelse for alla populationerna. Nollhypotesen om lika populationsmedel-
varde &r darfor detsamma som att testa om alla observationerna ar tagna ur samma population.

Stickprov 1: 33.5, 32.0, 32.5, 36.5

Stickprov 2: 39.5, 36.0, 34.5, 36.5

Stickprov 3: 32.0, 32.5, 33.5, 34.5

Stickprov 4: 36.0, 35.5, 33.5, 37.0

Precis som vid tva stickprov kan man vélja om man vill lasa in véardena i en kolumn, med
en kolumn bredvid som anger stickproven, eller att l&sa in stickproven i fyra olika kolumner.

Om man har last in i fyra kolumner skall man vélja

Stat » ANOVA » Oneway (Unstacked) ...,
medan man skall valja

Stat » ANOVA » Oneway...
om man har last in alla i en enda lang kolumn. Om man valjer varianten med en enda lang ko-
lumn kan man utvidga det nar man far mer avancerade modeller, och denna metod ar darfor
att foredra. | detta exempel har faktorerna lagts i variabeln faktor och responsen i variabeln
respons.
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One-Way Analysis of Variance E|

Response:! |respons
Factor: faktor

[~ Store fits

Confidence level: |35.0

| Qumparisuns...‘ Graphs... ‘

Help 0K | Cancel ‘

Resultatet som kommer ut i resultatfonstret blir

One-way ANOVA: respons versus faktor

Source DF SS MS F P
faktor 3 31.92 10.64 3.59 0.046
Error 12 35.56 2.96

Total 15 67.48

S =1.721 R-Sq = 47.30% R-Sq(adj) = 34.13%

Individual 95% Cls For Mean Based on
Pooled StDev

Level N Mean StDev ————4————————— o o R,

1 4 33.625 2.016 (-———-—---- * - )

2 4 36.625 2.097 (------—-- * )

3 4 33.125 1.109 (---—----- H e )

4 4 35.500 1.472 (——————-—- * o __ )
e o R R
32.0 34.0 36.0 38.0

Pooled StDev = 1.721

Den siffra som &r viktigast &r det p-vdarde 0.046 som visar att nollhypotesen om att
stickproven kommer fran samma population kan forkastas. Man far ocksa konfidensintervall

for varje enskilt stickprov utritade. L&gg dock mérke till att detta inte & samma

konfidensintervall som man far om man bara tittar pa ett stickprov at gangen, eftersom man

har har anvant den gemensamma standardavvikelsen nar man har gjort intervallen.

For att avgora vilka nivaer som skiljer sig at kan man anvanda [ Comparisons |. och vélja
vilken typ av jamforelse man skall gora. Da far man bokstaver som visar vilka nivaer som

skiljer sig at men Minitab producerar inte det sa kallade LSD-vardet.

Det namndes tidigare i avsnittet med tva stickprov hur man testar om varianserna i stick-

proven &r lika, och den metoden gar att anvanda aven pa fler stickprov.
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For att se om det finns nagra konstiga varden i datamaterialet ar det lattast att i menyn
vélja knappen och sedan Four in one. Detta ger fyra olika bilder av residualerna®
som var och en pa sitt satt sager om antagandena for analysen ar uppfyllda.

7.2. Ej normalfordelning och flera stickprov

Om man inte tror pa normalférdelningen och vill gora ett icke-parametriskt test, sa heter det
test som motsvarar den ensidiga variansanalysen for Kruskal-Wallis test. Om man vet hur
man gor ANOVA sa ar det enkelt att géra Kruskal-Wallis test pa samma séatt. Valj

Stat » Nonparametrics » Kruskal-Wallis...
och fyll i de tva rutorna. Detta ger

Kruskal-Wallis Test: respons versus faktor

Kruskal-Wallis Test on respons

faktor N Median Ave Rank Z

1 4 33.00 6.1 -1.15

2 4 36.25 12.4 1.88

3 4 33.00 4.9 -1.76

4 4 35.75 10.6 1.03

Overall 16 8.5

H=6.76 DF =3 P = 0.080

H=6.85 DF =3 P =0.077 (adjusted for ties)

* NOTE * One or more small samples

For att man skall kunna lita pa Kruskal-Wallis test maste det vara ganska manga varden i
varje stickprov, och sa ar inte fallet har. Darfor far man varningen pa sista raden. Har ar ocksa
tva p-varden, dar det andra har tagit hansyn till att nagra varden &r lika. Men p-vardet &r
saledes inte helt palitligt med sa har fa observationer. [

8. Blockforsok

Om man har ett blockforsék med normalférdelade observationer sa kan man inte anvanda me-
nyn for envags ANOVA utan maste anvanda den nagot mer avancerade proceduren General
Linear Model... Man maste ocksa ha last in sina varden i en kolumn pa det satt som angavs i
borjan av detta kompendium for att det skall fungera.

Exempel 7. Blockforsok

Kvavekoncentrationen i marken méttes pa jordprover tva veckor efter det att fyra organiska
gbdningsmedel (A, B, C eller D) hade tillsatts. Experimentet var upplagt som ett blockforsok
med tre block (I, Il, I11). Resultat:

> Det &r viktigt att komma ihdg att man inte skall kontrollera de ursprungliga observationerna utan istallet
residualerna som kan beskrivas som det som &r kvar att férklara nar man har tagit bort det som forklaras av
modellen.
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Block Behandling N

I A 3.85
10.70
8.60
10.95
4.25
11.85
9.35
11.80
5.60
9.15
8.40
7.55

OO wW>» 00 m>P>»OO®

Materialet lases in pa vanligt satt i Minitab och da kommer Block och Behandl ing att bli
textkolumner, men det fungerar i ett blockforsok.
For att nu gora en variansanalys for att se om det ar nagon skillnad mellan behandlingarna

(och om det &r en skillnad, var denna skillnad da &r), anvands General Linear Model...

Fle Edit Data Calt| Stat Graph Edtor Tools Wwindow Help

=dH & Basic Statistics ’F‘ S ? E ] ®EEa REE

| = : L B ——

& Cre-way...

Control Charts b EH Iwo-way...
20084 Quality Tools ¥ = Apalysis of Means... —
Reliabiliy/Survival b | B0V Balanced ANOWA...
Multivariate L= ear Model...
Time Series ¥ [EE Fully Nested ANOWA,
Tables 4
= Ay Balanced MANOVA, .
Monparametrics [ e
A eneral MANOVA, .,
Epa >

Power and Sample Size b i Test for Equal Yariances...
[tz® Interval Plat. ..
P4 Main Effects Plot...
%9 Interactions Plot. .

Menyn fylls i enligt

General Linear Model

X

C1  Elock Responses: | M
2  Behandling
[ ] Model:

Elock Behandling]

Random fackors:

Cogariates...| Opkions... | gomparisons...|

Graphs. .. | Results... | Storage. .. |

| Factor Plots... |

Help OF Cancel |
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och om man bara vill undersoka om det &r nagon skillnad utan att fa reda pa var skillnaden ar,
och utan att rita upp datamaterialet, sa racker det att fylla i menyn pa detta viset.
Resultatet blir

General Linear Model: N versus Block; Behandling

Factor Type Levels Values
Block fixed 3 1; 11; 111
Behandling fixed 4 A; B; C; D

Analysis of Variance for N, using Adjusted SS for Tests

Source DF Seq SS Adj SS Adj MS F P
Block 2 5.365 5.365 2.683 1.52 0.293
Behandling 3 67.147 67.147 22.382 12.66 0.005
Error 6 10.605 10.605 1.767

Total 11 83.117

S = 1.32945 R-Sq = 87.24% R-Sq(adj) = 76.61%
Ur detta kan man utldsa att det &r en tydlig skillnad mellan behandlingarna (p-vérdet ar
0.005 som gor att det &r signifikant pa nivan 0.01). Ur utskriften kan man ocksa se att det inte
var nagon stor skillnad mellan blocken.
Om man vill ha en bild av datamaterialet sa &r det mest lampliga vid blockforsok att rita
en sa kallad interaction plot som man hittar langst ned i ANOVA-menyn:

3 Minitab - Untitled

File Edit Data Calc stat Graph  Editor  Tools  Window Help

== =] Basic Statistics 4 ® ? @ ﬂ IE @ 5 ﬂ ‘E GE
’7 Regression i1 ~
] & oneway..
Control Charts ¥ HH Two-Way..,
Factor Type Quality Tools P = Analysis of Means. ..
Elock fixed it . .
3
Behandling fixed Reliability/Survival ADY Balanced AMOWA...
Multivariate ¥ | GLM General Linear Madel...
Time Serigs 4
inalysis of Terien , [EE Fully Nested AMOYA,
Tables 3

Souroe —_— A% Balanced MANOVA. ..

Monparametrics LA
Block 2 5 GLn General MANOWA. ..
Behandling 3 67 EDA L4
Error 6 10 Power and Sample Size b ”§§; Test for Equal Yariances. .
Tatal 11 88—

|iz® Inkerval Plat. .

FA Main Effacts Plat. ..
J = l.3Ea4s RoSg = BT.24F Rodgladd) pog TR

<
[
i C1.T 2T 3 4 5 C6 c7 8 9
Block |Behandling N
1 | A 385
2 1 B 10.70
3 | c 8.60

Det som skall fyllas i ar nu
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och resultatet blir

Interactions Plot

x)

C1  Block Responses:
ZZ  Behandling |N
Lot ]
Fackars:
Elack Behandling|
[ Display full interaction plak matrix
Options. ..
Help oK | Cancel |
Interaction Plot for N
Data Means
124 Block
—— |
114 —a— |l
1"
104
9
s 8
Q
= 7
6-
54
4-
3-

B ©
Behandling

Aven om man har har huggit av skalan pé& y-axeln sd framgar det att det inte ar sa stor
skillnad mellan blocken, daremot finns det i alla blocken samma monster for skillnaderna
mellan behandlingarna (dock en liten avvikelse i block I11). Ser man figuren kan man gissa att
behandling A kommer att visa sig ha signifikant lagre varde an de 6vriga, medan man inte
sékert kan sdga hur den 6vriga jamforelsen faller ut.

For att jamfora de olika nivaerna anvander man aterigen General Linear Model... men véljer

denna gang ocksa knappen| Comparisons...

, vilket

ger menyn

General Linear Model - Comparisons

Help

& Bairwise comparisons
" Comparisons with a control

Terms:

Method

v Tukey

=

[~ Bonferroni
™ sidak

19T

|w Grouping information
[ Confidence interval
[~ Test

Confidence level: | 95,0

Cancel |
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Har maste man fylla i rutan vid Terms: for att fa nagot resultat, och sedan kan man vilja
vilket test man vill ha (Dunnett’s test & sammankopplat med jamforelse med en kontroll och
ar darfor gramarkerad). Lagg ocksa marke till att Fisher’s test inte ar ett alternativ, Minitab
tycker inte att man skall anvénda det i detta sammanhang. Gor man inget mer an att fyller i
enligt

General Linear Model - Comparisons g]

1 Elock (* Pairwise comparisons

2 Behandling (™ Comparisons with a control

230N
Terrms:
Eehandling]
Method
v Tukey r
[ {+
[ Bonferroni i
[ Sidak
v Grouping information Confidence level: | 95,0
[ Confidence interval
[~ Test

Help [o]4 | Cancel |

sa blir resultatet (under den ANOVA-tabell som vi redan har presenterat) de tva utskrifterna

Grouping Information Using Tukey Method and 95.0% Confidence

Behandling N Mean Grouping

B 3 10.6 A
D 3 10.1 A
C 3 8.8 A
A 3 4.6 B

Means that do not share a letter are significantly different.

Sammanfattning: Det ar behandling A som signifikant skiljer sig fran de 6vriga, men dar-
emot kan man inte visa nagon signifikant skillnad mellan B, C och D.

9. Korrelation

Om man har tvadimensionella variabler kan man undersoka om det finns nagot samband
mellan de bada variablerna. Det vanligaste mattet pa detta samband ar korrelationskoefficien-
ten® som brukar betecknas p (grekiska bokstaven “ra"). Det p-varde man kan f4 &r ett p-varde
for nollhypotesen att korrelationskoefficienten ar 0 mot att korrelationskoefficienten inte &r 0.

® Den korrelationskoefficient som berdknas av Minitab brukar kallas Pearson’s korrelationskoefficient. Man ser
ibland istallet Spearman’s korrelationskoefficient som &r ett robust alternativ, men denna korrelationskoefficient
finns inte i Minitab.
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Exempel 8. Bomull
Man har varden pa regnmangd och skord av bomull. For att se om det finns ndgot samband
mellan dessa varden berdknas korrelationskoefficienten.

Regn (inches) Skord (Ib/acres)

7.12 1037
63.54 380
47.38 416
45.92 427

8.68 619
50.86 388
44.46 321

Korrelationskoefficienten berédknas genom
Stat » Basic Statistics » Correlation...

och om man vill ha p-vérdet kryssas rutan Display p-values.
Correlation §|

Yariahles:

rain yield

[ Store matrix [display nothing]
Help OK | Cancel |

Man kan stoppa in mer an tva variabler i rutan variables: och far da korrelationskoeffici-
enten for alla par av variablerna. | detta fall med tva variabler blir resultatet

Correlations: rain; yield

Pearson correlation of rain and yield = -0.836
P-Value = 0.019

Korrelationskoefficienten ligger alltid mellan -1 och 1, och hér har vi en stor negativ korrela-
tion. Det verkar alltsa som om lite regn ar relaterat till mycket bomull. [ |

Korrelationen mater linjart beroende mellan variablerna men ibland kan konstiga varden pa-
verka resultatet och darfor bor man ta for vana att rita en scatterplot 6ver sitt datamaterial nar
man beraknar korrelationer.
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10. Regression

Regression ar likartat med korrelation, men man skiljer det oftast genom att den ena variabeln
har ar nadgot man kan styra sjalv (x-variabeln) medan responsen y ar slumpméssig. Den varie-
rar emellertid kring en rét linje. Genom att gora regression kan man fa fram skattningen for
linjen, och man kan ocksa fa en bild 6ver den linje som &r skattad. Ett exempel far racka som
exempel pa detta.

Exempel 9. Koldioxid
Foljande data &r for koldioxidkoncentration (x) och upptaget i blad av vete (y).

Konc (x) 75 100 100 120 130 160 160 190 200
Upptag(y) 0.00 065 050 100 095 180 210 280 250
Det forsta man bor gora &r att anvanda plot-kommandot for att se om det &r rimligt att an-
satta en regressionsmodell, men vi lamnar det till lasaren. Minitab levererar anda en bild 6ver
data n&r man gor regression enligt nedan.
For att fa den ekvation som hor till linjen samt en del andra matt sa véljs

Stat » Regression » Fitted Line Plot...

Response [Y]: |v
Predictor [X]: ®

Type of Regression Model
+ Linear " Quadratic " Cuhic

Options... | Storage... |

_ seleat |
Help oK | Cancel |

Resultatet kommer bade i resultatfonstret och i en figur.

Regression Analysis: y versus X

The regression equation is
y = - 1.671 + 0.02214 x

wn
1

0.197510 R-Sq = 96.4% R-Sg(adj) = 95.8%

Analysis of Variance

Source DF SS MS F P

Regression 1 7.23193 7.23193 185.38 0.000
Error 7 0.27307 0.03901
Total 8 7.50500

Regressionsekvationen anges till y = -1.67 + 0.0221x, och den andra viktiga siffran ar p-

vardet 0.000. Om regressionskoefficienten ar 0 l6nar det sig inte att anvénda x-véardet for att
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forutse y-vardet. | detta fallet &r regressionskoefficienten
ocksa en figur 6ver regressionsekvationen enligt

signifikant skild fran 0. Man far

Fitted Line Plot
y= - 1.671 +0.02214 x

3.09 s 0.197510

R-Sq 96.4%

R-Sq(ad 95.8%
2.54 q(adj)

2.04

1.54

1.04

0.59

0.04

T T T T T T T T
60 80 100 120 140 160 180 200

11. Chi-tva-test

Om man har diskreta varden som man vill rdkna pa nagot satt sa ar det under avdelningen
Tables man skall leta. Har finns mojlighet att gora lite av varje, men det viktigaste 4r nog
méjligheten att gora sa kallade Chi-tva-test (y*-test). Man brukar dela dessa test i "goodness-
of-fit" och homogenitetstest. Goodness-of-fit férekommer till exempel ndr man har kastat en
tarning manga ganger och skall undersoka om den ar falsk. Homogenitetstest anvands for att
testa om tva eller flera populationer &r lika. Nu ar emellertid inte populationerna normalfor-
delade utan innehaller element som kan klassificeras i nagon klass. For att exemplifiera an-
vands samma exempel for bada testen.

Exempel 10. Tarningar
Det finns tre tarningar, en rod, en bla och en gron. For att undersdka om dessa tarningar ar
likvardiga kastar man tarningarna vardera 500 ganger och far resultatet

1 2 3 4 5 6
Rod 75 84 92 76 88 85
Bla 81 89 82 81 76 91
Gron 84 87 80 84 82 83
Man laser in data i tre kolumner enligt
red blue green
75 81 84
84 89 87:
92 82 80
76 81: 84:
88 76 82
85 91 83
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For att se om de ar likvardiga gor man ett homogenitetstest genom att vélja
Stat » Tables » Chi-Square Test (Table in Worksheet)...
och fyller i enligt

Chi-Square Test [Table in Worksheet) g|
C1  red Columns containing the table:
€2 blue red blue green
C3 green

Help oK Cancel

Resultatet i resultatfonstret blir

Chi-Square Test: red; blue; green

Expected counts are printed below observed counts
Chi-Square contributions are printed below expected counts

red blue green Total

1 75 81 84 240
80.00 80.00 80.00
0.313 0.013 0.200

2 84 89 87 260
86.67 86.67 86.67
0.082 0.063 0.001

3 92 82 80 254
84.67 84.67 84.67
0.635 0.084 0.257

4 76 81 84 241
80.33 80.33 80.33
0.234 0.006 0.167

5 88 76 82 246
82.00 82.00 82.00
0.439 0.439 0.000

6 85 91 83 259
86.33 86.33 86.33
0.021 0.252 0.129

Total 500 500 500 1500

Chi-Sq = 3.334; DF = 10; P-Value = 0.972

Det intressanta vardet ar det sista, 0.972, som visar att det inte & nagon signifikant skillnad
mellan de tre tdrningarna. Lagg dock mérke till man inte uttalar sig om huruvida tarningarna
ar falska eller ej, de kan mycket vél vara falska "at samma hall".
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Om man istallet staller fragan om den réda tarningen ar falsk gor man ett goodness-of-fit-
test (kallas ibland anpassningstest). Vélj da
Stat » Tables » Chi-Square Goodness-of-Fit Test (One variable)...

och sedan
Chi-Square Goodness-of-Fit Test g|
C1 ored
C2 blue * Observed counts: |red
C3 green
Category names (optional) : |
™ Categorical data: |
Test
{* Equal proportions
" Specific propartions
" Proportions specified by histarical counts:
4 Graphs... | Results. .. |
Help o] | Cancel |

Resultatet blir nu (férutom nagra figurer som ocksa produceras automatiskt)

Chi-Square Goodness-of-Fit Test for Observed Counts in Variable: red

Test Contribution
Category Observed Proportion Expected to Chi-Sq
1 75 0.166667 83.3333 0.833333
2 84 0.166667 83.3333 0.005333
3 92 0.166667 83.3333 0.901333
4 76 0.166667  83.3333 0.645333
5 88 0.166667  83.3333 0.261333
6 85 0.166667 83.3333 0.033333

N DF Chi-Sq P-Value
500 5 2.68 0.749

Slutsatsen av detta blir alltsa att det inte finns nagra bevis for att den roda tarningen skulle
vara falsk (p-vérdet 0.749 ar ju langt 6ver 0.05). m
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